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1.1. Software

PetroMod petroleum systems modeling software combines seismic, well, and 
geological information to model the evolution of a sedimentary basin. PetroMod 
software will predict if, and how, a reservoir has been charged with hydrocarbons, 
including the source and timing of hydrocarbon generation, migration routes, 
quantities, and hydrocarbon type in the subsurface or at surface conditions.

PetroReport provides detailed information on hydrocarbon masses and volumes 
generated and expelled from the source rocks as well as the amount that has 
migrated to and accumulated in reservoirs. The mass and volume of hydrocarbon 
losses are also displayed in detail.

Users are in full control of the way data is displayed. Values can be displayed and 
cumulated for all paleo events or shown for individual paleo times only, layers and 
components can be selected and de-selected as required.

Information can be copied and pasted into standard office applications 
(spreadsheets, presentations, word processors etc.) for preparing deliverable 
reports.

Who should use 
this software?

Specialist basin and petroleum system modelers whose responsibilities range from 
petroleum resource assessments on a regional scale, to petroleum charge risk 
assessments on a play or prospect scale.
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2.1. Open PetroReport

1 Open the PetroMod Command Menu.

Fig. 2-1 The PetroMod Command Menu

2 Click the Project Dir: button to change/create a project directory. The Select 
Project Path dialog will open. Select your path or create a new project. 

3 To open PetroReport, go to the Petro* tab and click once on the 
PetroReport icon (alternatively, click Petro* on the Menu bar and then 
PetroReport).



Open PetroReport
Fig. 2-2 Opening PetroReport from the PetroMod Command Menu

4 A dialog box will open. Select the model and click Open (you can select 1D, 2D 
and 3D models), The model will be loaded into PetroReport.
Getting Started 11
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2.2. Overview of the GUI

Fig. 2-3 The PetroReport GUI

The PetroReport interface consists of 5 panes - the Table, Options pane, 
Components pane, Events pane and Source Statistics pane (the Source 
Statistics pane is not shown in Fig. 2-3). 

Table

The Table shows detailed information on the masses and volumes of hydrocarbons 
that were generated and have migrated, accumulated and been lost. 

Components pane

The Components pane provides a graphical representation in the form of a pie 
chart (for masses and volumes) or bar chart (for balances) of the currently selected 
cell in the table. 

Events pane

The Events pane plots a mass or volume against time for the currently selected 
cell(s) in the table.

Source Statistics

The Source Statistics pane shows the amount of hydrocarbons that were 
generated and expelled from the source rocks. By default, it is not shown when you 
open PetroReport. Click the Source Statistics tab (next to the Event tab) to 
open the pane.

Options

Use the Options pane to change the way data is displayed, e.g. mass or volume, 
cumulative or for the current event only. See section 3.5. The Options Pane for more 
details.

Options pane

Components
Pane

Events 
pane

Table



Adjust the Layout of the GUI
2.3. Adjust the Layout of the GUI

Close and reopen 
panes

Close the Component, Event and Source Statistics panes by clicking the Close 
symbol in the top right corner of the pane. Reopen a pane by checking the 
respective pane on the Windows menu on the Menu bar.

Undock and 
docking panes

The docking feature enables you to adjust the working area to suit your own needs. 
You can undock and dock the Options, Component, Event and Source 
Statistics panes.

• Double-click on the title bar of a pane to undock it. Double-click again re-dock it.

Fig. 2-4 Undocking the Options pane

• Move an undocked pane outside the program area to prevent it from re-docking.

Double-click on title bar to
undock/dock panes
Getting Started 13
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• To move a pane to a different location, click on the title bar and drag the pane 
over the GUI. The blue background indicates where the pane will dock (see Fig. 2-
5). Release the mouse button to dock the pane.

Fig. 2-5 Dragging a pane to a different location and re-docking it

•  •  •  •  •  •
Note: The behavior and color of the background could be different depending on 

your operating system settings.

Save the changes 
to the layout

After you have adjusted the working area, save the changes with either the Store 
Layout command or the Auto Restore Layout option, otherwise the adjustments 
are lost when you close the program.

• To save the customized windows layout, select the command Store Layout from 
the Windows menu.

• To open a stored layout after program start, select the command Restore 
Layout from the Windows menu.

• The command Default Layout returns PetroReport to the default GUI layout.

• If the option Auto Restore Layout is selected, PetroReport will open 
automatically with the same layout it had before you last closed it. 
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3.1. Opening Models

When you first open PetroReport you are asked to select a model. The model is 
displayed in the Options pane. You can open additional models at any time. Each 
model is added to the Options pane.

•  •  •  •  •  •
Important: Before viewing models in PetroReport, make sure the models have 

been simulated using the Write Overlays for PetroReport option (in 
the Output folder of the Simulation 2D/3D Control Panel in the 
Simulator interface). Otherwise, PetroReport will show incorrect data.

1 Select File on the Menu bar and then Open Model... as shown in Fig. 3-1.

Fig. 3-1 Opening a model

A dialog box will open. Browse for a model and click Open. The model will appear in 
the Options pane as shown in Fig. 3-2.

Fig. 3-2 Loading a second model into PetroReport. The model is listed in the Options 
pane.



Viewing Data in the Table
3.2. Viewing Data in the Table

You can only view data for one model at a time in the table. Select the model on the 
Options pane to make it the active model (the active model is highlighted in blue 
on the Options pane). Data for the active model will be loaded into the Table.

The Table shows all the layers currently selected in Options pane.

• Click the  symbol to expand the model and layers in both the Options pane 
and the Table. 

• To add or remove layers from the table, check/uncheck the corresponding entry in 
the Options pane. 

In Fig. 3-3 the Table shows the layers that are checked in the Options pane.

Fig. 3-3 Check/uncheck layers in the tree to add/remove them from the PetroReport 
table.

The columns show the sum of the values for each component selected in the 
Options pane. Use the Ctrl and Shift keys to select multiple components. In Fig. 3-
4 all components are selected.

Fig. 3-4 Selecting the components

Click the “+” symbol next to a column heading to reveal more detailed information 
on that particular category (see Fig. 3-5).
Viewing Data 17
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Fig. 3-5 Expanding a category in the table.

Click the “-” symbol to collapse it again.

The table provides information on the following: 

Remaining Potential: The amount of remaining, i.e. not yet cracked, kerogen. It 
should typically decrease with time once the source rock has started to generate 
hydrocarbons. Exceptions are erosions of source rocks.

Generation Balance: Generated through primary and secondary cracking. The 
value should be positive inside source rocks and negative (or zero) outside. This is 
because nothing is generated outside the source rock primarily, but there can be 
losses due to secondary cracking (Cracked by Secondary Cracking plus Generated by 
Secondary Cracking).

Accumulated in Source: The amount of hydrocarbons accumulated either in the 
free pore space or adsorbed on the kerogen. When you expand the category on the 
table you will see either the oil and gas amounts or the liquid, vapor and water 
(hydrocarbons dissolved in water) amounts, depending on whether the Oil/Gas or 
Phase option is selected on the Options pane. These values should always be 
positive in Cumulative mode, but can be negative in Event mode if more 
hydrocarbons flowed out of the layer/polygon/facies etc. than migrated into it.

Expulsion Balance: By definition this is Generation Balance minus Accumulated in 
Source. Sounds simple but attention is needed for systems with multiple source 
rocks. The accumulated hydrocarbons could, for example, have migrated from a 
lower source rock. In this case the Expulsion Balance would have a negative value.

Accumulated in Reservoir: See Accumulated in Source, but without adsorption.

HC Losses Balance: Everything that was expelled but did not reach the reservoirs, 
i.e. Expulsion Balance = Accumulated in Reservoir + HC Losses Balance. In 
particular PetroMod distinguishes between hydrocarbons that i) migrated out of 
the sides of the model (Outflow Side), ii) reached the Surface Water Interface 
(Outflow top), and iii) are stuck in the shales (i.e. all layers which are neither a 
reservoir nor a source rock (Migration Losses)). The Migration Losses are further 
divided into Liquid and Vapor or Oil and Gas, depending on which mode is selected 
in the Options pane.

Migration Balance: Inflow minus Outflow of the specific layer or complete model. 
In the cumulative mode it should be positive for reservoirs and negative for source 
rocks.

•  •  •  •  •  •
Note:

•  In the table, “>” and “<” indicate that the sum does not include all facies 
in the current event.



Test mode
•  Mass and volume calculations in 2D models are based on an assumed 
width of 1km

Fig. 3-6 Overview of how the columns are calculated.

Test mode The values in the Generation Balance, Expulsion Balance, HC losses Balance and 
Migration Balance columns are calculated according to the equations shown in Fig. 
3-6. Use the Test mode to check whether the values in these columns have been 
calculated correctly. 

1 Before entering test mode, make sure all layers for the current event are ticked 
in the Options pane.

2 Now enter test mode. Open the Options menu and select Test Mode.

3 If the values in the Balance columns are correct, nothing will change in 
PetroReport. 

If the values in the Balance columns are incorrect, the word “nan” will appear in 
the respective cells in the Table (see Fig. 3-7). This indicates an error in the 
calculation. Please contact PetroMod Support for assistance (see Appendix: 
Help and Support Information).

•  •  •  •  •  •
Note: The display of data in the Components, Events and Source Statistics 

panes might also be affected in test mode.

Fig. 3-7 In test mode, columns with incorrect values are shown as “nan”.

4 To exit test mode, open the Options menu and select Test Mode again.
Viewing Data 19
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3.3. Viewing Data in the Components and Events Panes

Click a cell in the Table to view it in the Components and Events panes. Click a 
cell again to deselect it.

The Components pane always shows the most recently highlighted cell. 

The way data is displayed in the Events pane depends on the Behavior setting on 
the Options pane. The Behavior function contains three settings as shown in Fig. 
3-8.

Fig. 3-8 The Behavior settings

• Bulk: This is the default option. The Events pane shows a curve for each cell 
selected in the Table. 

• Oil/Gas: In this mode you can only select one cell at time in the Table. When 
you switch to this mode from the Bulk mode, the most recently selected cell 
remains active. The Events pane shows two curves for the active cell: one for the 
selected oil components and one for the selected gas components. 

• Components: In this mode you can only select one cell at time in the Table. 
When you switch to this mode from the Bulk mode, the most recently selected cell 
remains active. The Events pane shows a curve for each selected component.

In Fig. 3-9 the Behavior is set to Bulk and four cells are highlighted in the Table. 
The Components pane shows the most recently highlighted cell (in this case 
Accumulated in Reservoir) and the Events pane shows a curve for each of the cells 
highlighted in the Table.



View data for multiple models
Fig. 3-9 Highlight cells in the table to show them in the Components and Events pane.

More viewing options are located on the Options pane. See 3.5. The Options Pane

View data for 
multiple models

The Events pane can show data for multiple models. 

Select a model on the Options pane and then highlight the cells in the table. The 
highlighted cells of each model will be shown in the Events pane. 

Show gas and oil in 
different units on 
the Events pane

It is possible to show the oil and gas curves in different units on the Events pane.

1 Make sure that Volume is selected on the Options pane and that the 
Behavior is set to either Oil/Gas or Components. 

Set the Volume units. This determines the units in which the components are 
shown in all panes (see Fig. 3-10).

Fig. 3-10 Select the Volume units and the Behavior (Oil/Gas or Components).
Viewing Data 21
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2 Now change the units in Events pane. This determines the units in which the 
oil components are shown in the Events pane (see Fig. 3-11). The gas 
components continue to be shown in the units selected in Step 1.

Fig. 3-11 Changing the units in the events pane.

Show the Gas Oil 
Ratio (GOR) on the 
Events pane

Click the GOR button on the Events pane Toolbar to show/hide the GOR curve.

Change the colors 
of the curves in the 
Events pane.

The colors of the curves in the Events pane always match the colors of the cells in 
the Table. To change the color:

1 Right-click on the cell in the Table and select Change Cell Color from the 
context menu.

2 Select a color from the color pallet.

Show/hide the 
legend

The legend is particularly useful when displaying data from multiple models and/or 
multiple cells and layers.

Click the Legend button on the Events pane Toolbar to show/hide the legend.

Click the down arrow to open a dialog with options for adjusting the way the legend 
is displayed.
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3.4. Viewing Data in the Source Statistics Pane

Open the Source Statistics pane by clicking on the Source Statistics tab. The 
Source Statistics pane shows the amount of hydrocarbons that were generated, 
expelled or accumulated in the selected source rocks at any given paleo time. 

Statistics are shown for the source rocks selected in the Options pane. Values are 
summed across all selected source rocks. 

Fig. 3-12 The Source Statistics pane.

•  •  •  •  •  •
Note: When the Residual option is selected, only the Max Peak is shown.

Show statistics for either the amount of generated,
expelled or residual hydrocarbons.

Enter a percentage total.
PetroReport calculates by
when x% of hydrocarbons
had been generated/expelled

Enter a time [Ma]. 
PetroReport calculates 
the amount of 
hydrocarbons that had 
been generated/expelled 
by x [Ma].
Viewing Data 23
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3.5. The Options Pane

Use the Options pane to adjust the way data is displayed in PetroReport. The 
following subsections explain each of the functions.

Change the event By default PetroReport shows information at present day. Use the Event scroll box 
to change the event. 

Fig. 3-13 Changing the event

Cumulative or 
event and oil/gas 
or phase

Cumulative - view the sum of values for each event up to and including the 
selected event.

Event - view values for the selected event only.

•  •  •  •  •  •
Note: For the Accumulated in Source and Accumulated in Reservoir columns, 

Cumulative shows the current amount and Event the difference between the 
amount at the current event and the amount at the previous event.

Oil/Gas - the Accumulated in Source, 
Accumulated in Reservoir and Migration 
Losses columns in the Table show amounts 
for oil and gas.

Phase - the Accumulated in Source 
and Accumulated in Reservoir columns 
in the Table show amounts for liquid, 
vapor and HC in water



Show either mass or volume and change the units
Show either mass 
or volume and 
change the units

By default PetroReport shows the values in masses. Use the Options pane to 
view data in either masses or volumes and to change the units in which the data is 
displayed (see Fig. 3-14).

Fig. 3-14 Changing the display units

Volume and Surface Density

Fig. 3-15 Changing the surface density units and manually defining the oil and gas 
densities

Surface Density Unit:

When you check the Volume radio box, the Surface Density field becomes active. 
Select a surface density unit from the drop down list.

Default or User Defined:

PetroMod always takes the flashed surface densities. By default the oil and gas 
densities are obtained using a flash calculation with the given amounts of 
hydrocarbons (i.e. PetroMod shows the volumes you would get if you drilled into 
the specific layer(s) and not the current volumes in the layers (in-situ density)). 
Check the Default radio box to use the default densities. Check the User Defined 
radio box to manually enter densities for oil and gas.

•  •  •  •  •  •
Note: The oil and gas densities shown in the Options pane are used to convert the 

masses to volumes.

Surface density unit

User defined oil and
gas densities
Viewing Data 25
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Change the 
behavior

The Behavior function contains three items as shown in Fig. 3-16. These items 
change the way data is displayed in the Events pane.

Fig. 3-16 The Behavior options

• Bulk: This is the default option. The Events pane shows a curve for each cell 
selected in the Table. 

• Oil/Gas: In this mode you can only select one cell at time in the Table. When 
you switch to this mode from the Bulk mode, the most recently selected cell 
remains active. The Events pane shows two curves for the active cell: one for the 
selected oil components and one for the selected gas components. 

• Components: In this mode you can only select one cell at time in the Table. 
When you switch to this mode from the Bulk mode, the most recently selected cell 
remains active. The Events pane shows a curve for each selected component.

Show data for 
selected 
components 

By default, the Table, Event and Source Statistics panes show the sum of values 
for all components (the Component pane always shows each component). To view 
the sum for an individual set of components, click the component(s) in the Options 
pane. In the example in Fig. 3-17, the Table and the Event and Source Statistics 
panes will show values for Component_18, _10 and _17 only.

Fig. 3-17 Viewing individual components



Copy and Paste Data to Other Applications
3.6. Copy and Paste Data to Other Applications

The data in the Table, Component pane, Event pane and Source Statistics 
pane can be copied and pasted to other applications (e.g. spreadsheets).

Copy the table 1 Right-click anywhere on the Table and select Copy Table from the context 
menu as shown in Fig. 3-18. 

Fig. 3-18 Copying data.

2 Open your target application and paste the data.

Copy data from the 
Component pane

You can copy both the pie chart and the table from the Component pane. 

1 Right-click on the respective item and select either Copy or Copy Table 
from the context menu as shown in Fig. 3-19.

Fig. 3-19 Copying data from the Component pane

2 Open your target application and paste the data.

Copy data from the 
Events pane

1 Right-click anywhere in the Events pane and select one of the copy options:

• Copy Image to File: save the plot as an image file.
Viewing Data 27



Copy data from the Source Statistics pane
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• Copy Image to Clipboard: copy the plot to the clipboard for pasting into other 
applications

• Copy Data to Clipboard: copy the data represented in the plot to the clipboard

• Copy Data to File: save the data represented in the plot in an ascii file.

Copy data from the 
Source Statistics 
pane

1 Right-click anywhere in the Source Statistics pane and select Copy Table 
from the context menu.

2 Paste the table into your target application.



Appendix: Unit Settings

The Unit Settings are accessed via the Options menu on the Menu bar:

Fig. 4-1 The Units dialog

Display units 

The units in which a file/map/overlay etc. is displayed in PetroMod. These can be 
different from the units in which a file has been saved. For example, you can display 
depth information in feet even though the information is stored in the file in meters.

Import/export units

When you import a file, PetroMod assumes the file uses the units defined in the 
Import/Export column. If the input files use different units, you need to change the 
units in this column. When you export a file from PetroMod, it is exported using the 
Import/Export units.

Change the units 1 Open the Units tab

2 Double-click in a cell and select a unit from the scroll box (alternatively, right-
click and select Modify Cell(s)... followed by a unit)
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Fig. 4-2 Double-click on a cell to change the unit

•  •  •  •  •  •
Note: Any changes you make apply to the current session only unless you save 

them. See “Save the changes”.

Change the 
precision of the 
decimals

1 Go to the Decimals tab.

2 Double-click on a cell in the Precision column and type in a new value 
(alternatively, right-click and select Modify Cell(s)...)

Fig. 4-3 Changing the precision in the Decimals tab

•  •  •  •  •  •
Note: Any changes you make apply to the current session only unless you save 

them. See “Save the changes”.

Double-click in a
cell to change
the value



Change overlay and line object settings
Change overlay and 
line object settings

The Overlays tab lists all the overlays used by the Simulator. The columns contain 
default settings that determine the appearance of overlays and line objects, e.g. 
isolines. Use the Units dialog to change these default settings.

Fig. 4-4 The Overlays tab

1 Open the Overlays tab

2 Double-click in a cell. Depending on the column, either type in a new value or 
select a new value from the scroll box.

•  •  •  •  •  •
Note: Any changes you make apply to the current session only unless you save 

them. See “Save the changes”.

Column Description

Calculate Tell the simulator to either generate or not generate an 
overlay.

“No” = do not calculate overlay 

“Yes” = calculate overlay

RangeType Fixed Range: The color scheme will be applied to the 
range of values specified in the FixRangeMin and 
FixRangeMax columns.

Model Range: The color scheme will be applied to the 
range of values found in the model. When this option is 
active, any values in the FixRangeMin and FixRangeMax 
columns will be ignored.

FixedRangeMin The minimum value of a fixed range overlay.

FixedRangeMax The maximum value of a fixed range overlay.

ColorScheme The default color scheme for the overlay.

LineColor This column determines the default color of line objects, 
e.g. isolines, curves on plots etc.

LineWidth Adjust the default line width.

LineStipple Adjust the default line stipple.

Overlays Lines
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Save the changes If you do not save the changes, they will be lost the next time you close the 
application. There are two ways to save the changes - either apply them project-
wide or save them for the current session only.

Apply the changes 
project-wide

Use the Apply to Project button to apply the changes project-
wide.

Apply the changes to 
the current session only

If you want to keep the changes for future work but do NOT want to apply them 
project-wide, do NOT use the Apply to Project button. Instead, save the session 
via the Save Session as... command on the File Menu. You can re-load the 
session later. 

Reload the project 
default settings

 Click the Project Default button to reload the project default 
settings.



Appendix: Help and Support 
Information

PetroMod is provided by © Schlumberger. The software has been designed by the 
Schlumberger Aachen Technology Center (AaTC).

PetroMod Support

For general questions concerning PetroMod please follow the standard procedure 
within the Customer Care Center via the Schlumberger Support Portal at https://
support.slb.com. 

Choose New incident, then select PetroMod as the Product and the respective 
application as the Product module. 

Additional Help Information

PetroMod provides the following help information:

• The PDFs of the user guide, installation guide, and release notes are included in 
the installer and can be downloaded on the PetroMod Documentation page of the 
Schlumberger Support Portal.

• The information dialogs within the process dialogs are opened by clicking or 
hovering over the question mark button. They provide detailed help concerning 
the content of that process

• Online help found in the Help menu in the application.
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